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 Purpose 

 This manual provides a reference for users of the Augment Automotive 3D Tuner application 
 version 2.1. Typical users are engine tuners and customers who have purchased our AugTronic 
 ECU who are calibrating their own engine themselves. 

 The functions of the 3D tuner software include: 

 1.  Editing calibration files for AugTronic ECUs in offline mode. 
 2.  Saving and loading calibration files from/to connected AugTronic ECUs. 
 3.  Carrying out data logging and diagnostics for AugTronic ECUs. 
 4.  Carrying out engine calibration of an AugTronic ECU. 

 There are a number of supporting manuals as well as installation manuals and a quick start 
 guide for customers installing and configuring their own ECU. It is recommended that these 
 manuals are read along with this one when first starting out with AugTronic ECUs. 

 Scope 

 This manual covers the operation of Augment Automotive 3D Tuner at version 2.1 specifically. It 
 may be partially relevant to other future versions of 3D Tuner. This version of 3D Tuner is only 
 for use with specific versions of our AugTronic ECU firmware. Typically 3D Tuner will display an 
 error message if it is connected to an incompatible AugTronic ECU. If you are unsure if you 
 have the correct version please contact Augment Automotive for support. 

 Primarily this manual is designed for users who understand engine calibration and need to know 
 how to manipulate the 3D Tuner software. It is not intended as a guide to tuning engines. 
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 Introduction 

 Augment Automotive 3D Tuner is a Windows based software application which provides a 
 number of functions in support of Augment Automotive’s AugTronic ECU. Primarily it is 
 designed to manipulate the calibration data stored within the AugTronic ECU to adapt it for a 
 specific engine. In addition to this it also provides data logging and diagnostics functions and the 
 facility to save, load and manipulate calibration files which represent the data stored within an 
 AugTronic ECU. 

 The Augment Automotive AugTronic ECUs support connection to a computer via a USB or 
 Bluetooth Serial connection. 

 Once the 3D tuner application is connected to the AugTronic ECU data logging and diagnostic 
 data is continuously retrieved from the AugTronic ECU. Other functions are initiated by the user 
 as and when required and these are carried out in series with data logging requests. 

 Installing 3D Tuner 

 Augment Automotive 3D Tuner is intended for use on Windows 10 computers, but may work on 
 some earlier versions. Typically a 64-bit version is provided as this covers the majority of 
 modern computers. On request 32-bit versions may be provided. 

 Installation is done using a dedicated installer which is typically available on the Augment 
 Automotive website. Once downloaded the installer can be executed and will take the user 
 through several prompts before installing the application. If you require support with installation 
 please contact Augment Automotive Limited. Once installed shortcuts should be available on 
 the Start Menu or Windows Desktop which can be used to launch the application. 
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 Starting Augment Automotive 3D Tuner 

 Click on one of the available shortcuts to start the 3D Tuner application. Alternatively locate the 
 install directory and double click the 3D Tuner executable. Once started a launch window will 
 appear as shown below. Select the screen resolution, graphics quality and whether the 
 application should run in a window. If the application runs slowly, reduce the resolution and or 
 graphics quality to suit your computer. Press “Play” to start the tuning application. 

 Once started the 3D tuner application is in offline mode which will allow calibration files to be 
 loaded, edited and saved to the computer's hard drive. 

 Information about the version of 3D tuner can be viewed on the About Screen which is 
 accessed from the help menu. Left click on Help then About to view the About Screen. 

 The About Screen also gives useful information about the connection status of an AugTronic 
 ECU. This includes its firmware information and the amount of data transferred. 
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 Connecting to an AugTronic ECU 

 In order to carry out the following functions 3D Tuner needs to be connected to an AugTronic 
 ECU: 

 1.  Saving and loading calibration files from/to AugTronic ECUs. 
 2.  Carrying out data logging and diagnostics for AugTronic ECUs. 
 3.  Carrying out live engine calibration of an AugTronic ECU. 

 Configure a COM port  (a type of external device communication port found on many 
 computers) as per the “Augment Automotive Serial Connection Manual”. Once your COM port 
 has been configured you can connect 3D tuner to the AugTronic ECU. COM ports have a 
 numerical designation such as COM1 which represents a specific device that can be 
 communicated with. 

 3D Tuner will typically attempt to connect to any available COM port on the system. This will 
 typically find any connected AugTronic ECU. However in some cases it may be necessary to 
 select a specific COM port. It can also be quicker to connect if there are a lot of COM ports on 
 the system for example. 

 To select the COM port open the communications window. To do this select ‘Window’ -> 
 ‘Communications’ from the top menu bar. 

 Augment Automotive Limited - 3D Tuner Manual - 006  Page  6  of  30 



 A specific COM port can then be selected from the Communications drop down menu. 

 When trying to connect to and AugTronic ECU 3D Tuner displays a flashing magnifying glass 
 above the serial port connector icon. 

 A flashing blue and yellow SYNC icon in the top right indicates the ECU is connected. A popup 
 message will also state the ECU is connected. 

 If 3D Tuner already has a calibration file loaded when it connects to an AugTronic ECU it will 
 compare its calibration to that of the ECU. If it matches it will connect automatically as it is 
 syncronised. If there is a mismatch it will ask the user which calibration file it wishes to keep. 
 Either the file received from AugTronic or the file currently loaded in 3D tuner. The file that is 
 discarded is overwritten. Data can be lost in this way if the AugTronic or 3D Tuner calibration file 
 is not saved to disk. 
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 Saving and Loading ECU Configurations 
 ECU configurations can be loaded from and saved to the computer's hard disk for backup and 
 sharing. There are two file types: a binary file which has a “.augee” extension and an XML 
 format file which has a “.augml” file extension. The XML file type can be edited using a simple 
 text editor which can be useful in some situations. 

 Saving and Loading is done through the “File” menu. Left click on the “File” menu button and 
 select “Save” or “Load to gain access to the “Save” and “Load” functions. 

 A drop down list on the File Browser window can be used to select between file types. 

 Saving and loading functions can be used in offline mode and when connected to an AugTronic 
 ECU. When offline a file must be loaded and can then be edited and saved again. When 
 connected to an AugTronic ECU the functionality is the same except that when a file is loaded it 
 is immediately sent to the AugTronic ECU as an update. It is recommended that the engine be 
 stopped when loading a calibration file to a connected AugTronic ECU. 
 When saving, enter the file name in the text box or click on an existing file then hit the save 
 button. If the file exists it will not be overwritten but the name appended with a number that 
 generates a unique name. When loading left click a file from the scrollable list of files and click 
 load. 
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 Data Logging and Diagnostics 

 3D Tuner is able to retrieve live data, including fault diagnostics, from the AugTronic ECU. This 
 includes information about the state of the ECU and the connected engine. 

 When connected to an AugTronic ECU live data is continuously stored in CSV format to the Log 
 folder within the 3D Tuner installation directory. This data can be viewed in various external 3rd 
 applications that will generate graphs showing how the different parameters vary over time. 

 A good example is MegaLogViewer which can be found at: 

 https://www.efianalytics.com/MegaLogViewer/ 

 3D Tuner also has the ability to display the real time data in real time using the following 
 facilities: 

 ●  The customisable Dial system which also provides user configurable alarms 
 ●  The Summary Window 
 ●  The Log Browser windows 

 Dial System and Alarms 

 3D Tuner has a Dial system which consists of one or more customisable and positionable Dial 
 windows which display current, min and max values for a user selectable parameter and 
 additionally allow for Alarm setpoints to be configured to alert the user to an undesirable state. 

 A new Dial can be added to the 3D tuner window by left clicking the “Playback” menu and then 
 left clicking “Add Dial”. 
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 This will create a new floating Dial window that can be moved around the screen by left clicking 
 and holding to the dark grey area at the top whilst moving the mouse to locate the window. This 
 way a user customisable layout of key parameters can be created. Multiple dial windows can be 
 added in this way. When the Graph checkbox is selected a graph of previous values is 
 displayed. 

 Each Dial has the same layout. A dropdown window at the top allows the user to select the 
 parameter of interest. Click boxes allow the user to select Graph, Alarm and whether the min 
 and max values are based on observed (dynamic) data or fixed limits already in the software. 

 When the Alarm tick box is selected additional numerical input fields are provided. These allow 
 the user to set min and max values outside of which the screen will flash red and an alarm will 
 sound. This is useful for example for coolant temperature when on a rolling road. 
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 Summary Window 

 In order to display key values in a concise way a summary window is provided. It can be 
 displayed by left clicking the Playback menu and then left clicking Summary. 

 This will bring up the summary window that can be moved around the screen by left clicking and 
 holding to the dark grey area at the top whilst moving the mouse to locate the window. It can 
 also be resized by left clicking and holding on the icon in the bottom right whilst moving the 
 mouse. 
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 As per the Dial system the min and max values can be derived from the observed (dynamic) 
 data or from fixed min and max values set in the software. Left clicking the “Reset Data” button 
 will reset the observed (dynamic) min and max values. 

 Log Browser 

 The log browser can be used to view graph trends of up to 3 parameters at the same time. 
 Multiple Log Browser windows can be added to the 3D Tuner display and they can be moved 
 and resized in the same way as the summary window. 

 Left clicking on any of the 3 drop down windows allows for a different parameter to be selected. 
 The 3 parameters are coloured Red, Yellow and Green which correspond to the colour of the 
 dropdown box, the colour of the graph line and to the value markers. Left clicking on the log 
 browser window to select it and then pressing the I and O keys allows the timescale to be 
 adjusted so a longer period of time can be observed. If the cursor is placed over the graph area 
 a white rectangle will be highlighted and the mouse wheel can then be used to adjust the 
 timescale and left clicking and holding will give the value of the data at the point where the 
 mouse is clicked. This can be used to find peak values etc. As per the Dial and Summary 
 window min and max values can be selected between observed (dynamic) data and fixed min 
 and max values in the software. 
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 Fault Summary 

 A Fault Summary window can be accessed by left clicking the Window menu and then left 
 clicking on Fault Summary. 

 This will bring up a new window that shows the status of a number of different fault flags sent 
 from the AugTronic ECU to 3D Tuner. When the error flag is displayed green there is no error 
 and when it is orange an error is present. Each error has a brief description of the error, for 
 further information on an error please contact Augment Automotive. Error flags are not stored 
 and any error is cleared on a reset of the AugTronic ECU if the fault condition is no longer 
 present. 

 A full list of fault flags and their meanings is provided in Appendix 5. 

 When a ‘Test Value’ of 9 is set the ‘Throttle Sensor Error’ flag will go faulty to indicate the closed 
 throttle switch is in the closed position. This can be used to diagnose issues with the throttle 
 switch. For example if the AugTronic ECU is not going into idle control mode. 
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 Calibration Maps 

 In  the Augment Automotive 3D tuner the calibration maps on the AugTronic ECU are 
 represented as 2D or 3D grids that can be selected by left clicking on the “Grid” button and left 
 clicking an option. The number keys 1-9 can also be used to select maps 1-9 respectively. 

 The displayed 2D or 3D grid can be panned by holding the TAB or Middle Mouse button whilst 
 moving the mouse. In a 3D grid holding the right mouse button will rotate the map view. In order 
 to do this the main window must be selected by left clicking anywhere in the window. A grey 
 highlight is present around the window when it is selected. 

 See the Hotkey section in Appendix 1 for controls used in manipulation of the grids as part of 
 the tuning process. 
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 The grid points are manipulated by selecting a single point by left clicking or by holding the left 
 mouse button and dragging over a group of points and releasing the left mouse button. 

 The point values can then be altered by pressing or holding the up or down arrows. The shift 
 key can be used to increase the rate of increase/decrease. The ‘Q’ or ‘A’ keys add and subtract 
 5% from the selected value. 

 Grid point labels showing the value of each data point can be displayed only on the selected 
 points or on all points by toggling the “Label all points” option in the “Options” menu. The size of 
 the point label text can be adjusted with the ‘M’ and ‘N’ keys The position of the grid sites can be 
 adjusted in “Grid Manipulation Mode” which can be selected under the “Mode” menu. 

 For a description of the function of each map see the ‘AugTronic Map Description’ section in 
 Appendix 4. 

 A command window can be used to carry out mathematical operations on one or more selected 
 points. The ‘C’ key is used to open the command entry window. For a list of commands see the 
 ‘Command Terminal’ section in Appendix 2. 
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 ECU Configuration 

 Various ECU configuration parameters are available through left clicking on “Window” then 
 “Configuration”. This brings up the ECU configuration window. These values control many 
 important aspects of the AugTronic ECU. 

 This will bring up the Configuration window which can be used to view and edit important 
 parameters of the AugTronic ECU configuration. The parameters are split into groups and each 
 group can be viewed by left clicking on the buttons at the top of the window. As per other 
 windows the Configuration window can be moved and resized. 

 Values can be edited by clicking in the text box associated with the parameter being altered and 
 then clicking the Set button. When the parameter is altered the box is turned red. When the set 
 button is pressed the box will turn green if the value is within limits. Each value has a maximum 
 and minimum limit. For descriptions of each value and how to determine the correct value for 
 your engine see the AugTronic Configuration section in Appendix 3. 
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 Saving ECU Memory 

 Changes made to the AugTronic ECU configuration in live mode are not permanent. They will 
 be lost when the AugTronic ECU loses power. In order to make the changes permanent, open 
 the Communications window. 

 Click the Set EEPROM button in the Communications window. 

 Once EEPROM saving is complete the activity indicator in the top right will flash (usually 
 immediately unless lots of changes have been made). In addition a popup should state the save 
 operation has completed. In some cases if a lot of data is changed 3D tuners connection may 
 timeout. This is because saving the memory can take a long time. In this case simply wait for 3D 
 Tuner to reconnect and the changes should be saved. To confirm you can click Set EEPROM 
 again after it is reconnected. 

 If modifications are made to the AugTronic configuration and the ECU is reset the changes will 
 be reverted on the ECU. If the changes are not stored within 3D Tuner the changes are lost 
 permanently. If 3D Tuner reconnects to the ECU and the user chooses to discard the data in 3D 
 Tuner then the changes can be lost from 3D Tuner as well. If you accidentally reset the 
 AugTronic ECU with unsaved changes then it is best to save the calibration file to disk 
 immediately to prevent possible loss of work. 
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 Orthographic View 
 To help locate the engine on a particular site during tuning an orthographic view is provided. It 
 can be enabled through the “Options” menu. 

 The window can be dragged via the top bar to an appropriate position on screen. 
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 Appendix 1 - Hotkeys 

 Key  Function 

 I  Zoom in 

 O  Zoom out 

 L  Lock selected grid site for editing 

 U  Unlock selected grid site for editing 

 Left Mouse  Select point 

 Hold Right Mouse  Rotate grid 

 Hold Middle Mouse/Tab  Pan grid 

 M  Increase size of grid site labels 

 N  Decrease size of grid site labels 

 Press Up Arrow  Increase value of grid site by one increment 

 Press Down Arrow  Decrease value of selected grid site by one increment 

 Hold Up Arrow  Increase value of selected grid site by 3% per second 

 Hold Down Arrow  Decrease value of selected grid site 3% per second 

 Left Shift  Hold to force change in value of point of 40% of range per 
 second while up or down error is held 

 Q  Increase value of selected grid site by 5% 

 A  Decrease value of selected grid site by 5% 

 C  Bring up the command terminal. 

 P  Auto detect com port (Experimental - application may freeze 
 while searching) 
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 Appendix 2 - Command terminal 
 As of 3D Tuner version 1.27 a command terminal can be brought up by pressing ‘c’. This feature 
 is only active on 3D maps. This can be used to set and manipulate the values of single or 
 multiple data points on the maps. The command terminal accepts a number of command value 
 inputs e.g. =100 would set all selected points to a value 100. The following commands are 
 available: 

 Command  Value  Description 

 +  decimal e.g. 10.1  Add the value to the selected data point(s) existing 
 value(s) 

 -  decimal e.g. 10.1  Subtract the value from the selected data point(s) 
 existing value(s) 

 *  decimal e.g. 10.1  Multiply the selected data point(s) existing value(s) 
 by the value 

 =  decimal e.g. 10.1  Set the existing data point(s) value(s) to the value. 

 Also sets the value of the last value moved in grid 
 manipulation mode. 

 /  decimal e.g. 10.1  Divide the selected data point(s) existing value(s) 
 by the value 

 l (lower case L)  none  Set the value(s) of the data point(s) selected to the 
 value left of it 

 d (lower case D)  none  Set the value(s) of the data point(s) selected to the 
 value below it 

 i (lower case I)  none  Interpolate the value(s) of the data point(s) selected 
 using the values below them. 
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 Appendix 3 - AugTronic Configuration Parameters for AugTronic 
 Firmware 1.22 

 Name  Description 

 Triggering 

 Teeth per revolution  The number of teeth counted in one revolution of the flywheel 

 Stroke tooth set on reference 
 pulse 

 The internal stroke counter value set when the reference pulse is 
 seen 

 Rotation tooth set on reference 
 pulse  The internal rotation tooth set when the reference pulse is seen 

 Cylinder banks 
 The number of cylinder banks (pairs) e.g. for a 4 cylinder there are 
 2 

 Cylinder bank offsets (1-3) 

 The offset of each cylinder bank in teeth/16 this allows for 
 correction of errors due to alignment of the top dead position for 
 the bank with a tooth edge 

 Cylinder TDC tooth (1-3) 

 The TDC (TD really) tooth for each cylinder bank specifies at what 
 point in the rotation of the engine the cylinder bank reaches its top 
 dead position 

 MAP Sample Tooth  The stroke tooth on which the MAP is measured 

 Ignition 

 Wasted spark mode 

 0 - Wasted spark disabled 
 1 - Wasted spark enabled on internal header 
 2 - Wasted spark enabled on breakout box 

 Fuel 

 Engine coasting fuel cut enabled  Enables/disables fuel cut on the overrun 

 Engine coasting RPM limit  Determines the RPM below which fuel cut is disabled 

 Injections/4 Stroke Cycle 
 The number of times the injectors are batch fired per engine cycle 
 (2 rotations) 

 Closed loop fueling enabled  Enables/disables closed loop fueling 

 Closed loop fueling coarse 
 adjustment 

 The value in percent that the closed loop fuel is adjusted for larger 
 errors 

 Closed loop update frequency 

 The frequency at which the AFR is sampled and the closed loop 
 fueling algorithm executes. This is a value for an 87hz counter so 
 a value of 9 would cause the loop to run approx every 0.1 seconds 

 Closed loop max correction  The maximum correction that can be applied in closed loop 

 Closed loop accel limit 
 The limit above/below which closed loop is disabled for engine 
 speed rate of change 
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 Fuel map load 
 0 - Fuel map load is derived from manifold pressure 
 1 - Fuel map load is derived from manifold air density 

 Transient fuel pooling percentage 
 The amount of fuel in percent of base fuel time that is assumed to 
 be pooled e.g. on the internal surfaces of the manifold etc 

 Transient fuel recover percentage 

 The rate at which the fuel pool size corrects itself during transient 
 periods in percentage of the difference between the current pool 
 value and the new one 

 Sensors 

 EGT Source  The ADC channel which EGT is being measured on 

 MAP sensor min value  The minimum value of the MAP sensor e.g. 200 mBar 

 MAP sensor max value  The maximum value of the MAP sensors e.g. 4000 mBar 

 MAP sensor min offset 
 The ADC offset of the minimum MAP sensor value e.g. for 0.4V 
 the value is 0.4 / (5/1023) = 82 

 MAP sensor max offset 
 The ADC offset of the maximum MAP sensor value e.g. for 4.8V 
 the value is 4.8 / (5/1023) = 982 

 MAP Low Error Filter  Filter constant used when error is small 

 MAP Med Error Filter  Filter constant used when error is medium 

 MAP High Error Filter  Filter constant used when error is large 

 Engine Speed Filter  Engine speed filter constant 

 Wideband min value 
 The minimum value output by the wideband sensor multiplied by 
 100 e.g. 850 for (8.5:1 AFR) 

 Wideband max value 
 The maximum value output by the wideband sensor multiplied by 
 100 e.g. 1800 for (18:1 AFR) 

 Wideband min offset 
 The minimum voltage offset in bits (255 is 5V) e.g. for 0.5V value 
 = 0.5 / (5 / 255) = 25 

 Wideband max offset 
 The maximum voltage offset in bits (255 is 5V) e.g. for 4.5V value 
 = 4.5 / (5 / 255) = 230 

 TPS closed ADC 
 The TPS raw value for the throttle closed position e.g. for 0.4V the 
 value is 0.4 / (5/1023) = 82 

 TPS open ADC 
 The TPS raw value for the throttle open position e.g. for 4.8V the 
 value is 4.8 / (5/1023) = 982 

 Idle Control 

 Idle coastdown Deccel Boost 
 Limit 

 The rate of engine deceleration that causes the idle valve to open 
 by the amount specified by the Idle Coastdown Boost Idle Valve 
 PWM Boost. 

 Idle Coastdown Boost Idle Valve 
 PWM Boost  The amount to increase the idle valve opening by in % duty. 

 Idle Fuel Filter  The filter constant for the fuel injected when idling. 
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 Idle Target  The target idle speed 

 Idle Engine Speed Filter  The filter constant for the engine speed when idling. 

 Idle Ignition Advance Mode 
 0 - Use the Ignition Map 
 1 - Ignition set to Throttle Closed Ignition Advance map. 

 Idle Disable Transient Fuel  Disables transient fueling when idling. 

 Idle PWM Integral Gain  The integral gain for PWM idle control 

 Idle PWM Max Integral Gain  The maximum integral amount. 

 Idle PWM Frequency  The rate of execution of the idle control algorithm. 

 Idle PWM Slow Rate Threshold 
 The threshold engine speed error that causes the idle control 
 algorithm to slow. 

 Idle PWM Slow Rate Counter 
 The number of executions that are required before an adjustment 
 is made to the idle PWM duty. 

 Cranking 

 Cranking RPM threshold 
 The RPM value above which the ECU switches from cranking to 
 normal running parameters 

 Cranking dwell teeth 
 The number of flywheel teeth that the ignition is in dwell during 
 cranking 

 Cranking idle valve boost  The idle valve duty boost when cranking. 

 Rev Limit 

 Rev limit  The RPM above which the fuel cut is activated 

 Rev limit hysteresis 
 The RPM below the rev limit at which fuel is re-enabled following a 
 cut 

 Rev limit limp mode RPM 
 The rev limit if the ECU is in limp mode due to position sensor 
 faults 

 Boost Control 

 Boost solenoid MAP trigger  The MAP value above which the boost solenoid is enabled 

 Boost solenoid TPS control 
 enabled 

 Enables/disables scaling of the boost solenoid pulse width by TPS 
 value 

 Boost solenoid TPS trigger 

 The TPS value which is used to scale the boost solenoid pulse 
 width from e.g. 600 would scale the boost solenoid duty from 0 to 
 Max linearly from 600 to the TPS open ADC value 

 Test 

 Debug  Not for end user use 

 Test Value 

 1.  Test fuel pump 
 2. Test boost solenoid 
 3. Batch injection test value 
 4. Batch injection test value 
 5. Select speed sensor rising edge trigger 
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 6. Disable the ref sensor above “Rev limit limp mode RPM” 
 7. Test the ignition coil 
 8. Enable a low pass MAP filter instead of the default map 
 averaging function 
 9. Generate a Throttle Error when the throttle is closed to test 
 throttle closed switch 
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 Appendix 4 - AugTronic Map Descriptions 
 Each calibration map is used in conjunction with input values to calculate a current map value 
 which is used by the ECU for specific purposes. A technique called linear interpolation is used 
 to calculate the current value when the inputs do not align with a specific point on the map. 

 Maps can be 3-Dimensional and 2-Dimensional. This depends on the need for any specific 
 calculation. 

 Fuel Map 
 The ‘Fuel Map’ contains the calibration data that the AugTronic ECU uses to derive its ‘Base 
 Fuel Time’. This is a time in milliseconds that the injector will be open for over the course of a 
 4-stroke cycle. Multiple adjustments are applied to this base map before the fuel is injected so 
 this is typically not the final value injected. 

 In the linear region of injector operation the time that the injector is open is proportional to the 
 mass of fuel injected. 

 The ECU interpolates a ‘Base Fuel Time’ based on ‘Engine Speed’ and ‘Fuel Map Load’. ‘Fuel 
 Map Load’ is either Manifold Absolute Pressure’ or a calculated ‘Air Density’ dependent on the 
 setting of ‘Fuel Map Load’ in the ECU configuration settings. 

 Ignition Map 
 The ‘Ignition Map’ contains the calibration data that the AugTronic ECU uses to compute its 
 ‘Base Ignition Advance’ This is an advance in degrees back from the pistons top position in the 
 cylinder bore. Currently only positive ignition advance is supported. Multiple adjustments are 
 made to this base map before the ignition timing is used to generate a spark. 

 This map is bypassed when the engine is cranking or the throttle is closed and ‘Idle Ignition 
 Advance Mode’ is set to 1 in the configuration menu. Under these conditions separate map 
 tables are used to determine the ‘Base Ignition Advance’. 

 Fuel Air Temperature Compensation 
 The fuel air temperature compensation map applies a % modification to the ‘Base Fuel Time’ 
 dependent on the current ‘Intake Air Temperature’. It should be used differently depending on 
 the way that the AugTronic ECU calculates fuel map load. 

 If ‘Manifold Absolute Pressure’ is used as fuel map load then this should be used to compensate 
 for changes in air density due to ambient air temperature. It can also be used to alter the Air 
 Fuel Ratio based on the air temperature. 

 If ‘Air Density’ is used as fuel map load then this should be used to alter the Air Fuel Ratio 
 based on the air temperature. For example, richening the mixture for high air temperature to 
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 reduce combustion temperatures and prevent engine knock. 

 This is not applied to cranking fuel. 

 Charge Temperature Factor 
 Due to the length of time the air takes to travel the intake path the intake air can warm up to 
 wards engine temperature. This factor takes an approximation of gas flow and estimates the 
 Charge Temperature used in fuel calculations as a factor between Intake Air Temperature and 
 Coolant Temperature. 100% would mean that the Charge Temperature is Coolant Temperature. 
 0% would mean that the Charge Temperature is Air Temperature. 

 Cranking Fuel Time 
 This map is the ‘Compensated Fuel Time’ when the engine is cranking. It is derived from the 
 ‘Coolant Temperature’ alone. Injector dead time is also included in this map as the battery 
 voltage is unstable during this cranking period. No air or coolant Temperature modifiers are 
 applied to this value. 

 Cranking Ignition Advance 
 This map is the ‘Compensated Ignition Advance’ when the engine is cranking. It is derived from 
 the ‘Coolant Temperature’. No air or coolant temperature modifiers are applied to this value. 

 Startup Fuel Enrichment 
 This map is a % modifier applied to the ‘Base Fuel Time’ immediately after the engine is started. 
 The map is based on runtime and coolant temperature. The fuel modified is calculated and 
 applied to the fuel calculations. 

 Transient Fuel Clamp 
 This map is a percentage of the base fuel time that represents the maximum amount of fuel that 
 can be applied by the transient fuel enrichment algorithm. This algorithm ensures that the 
 mixture does not go excessively lean when the engine load is changed rapidly. A limit should be 
 applied to prevent the mixture being excessively rich but permitting an adequately fast response 
 to transient conditions. 40% is a common value at low to moderate engine speeds. The need 
 typically diminishes at higher rpm. It is used in conjunction with the ‘Transient Pool Percentage’ 
 and ‘Transient Recovery Percentage’  to compute the final ‘Transient Fuel Enrichment’. 

 Ignition Air Temperature Compensation 
 This table is used to compensate the ignition advance for changes in air temperature. This can 
 be used to compensate for reduced flame speeds at low temperatures or to retard ignition at 
 high temperatures to prevent engine knock. 

 This is not applied to cranking ignition advance. 

 Ignition Coolant Temperature Compensation 
 This map is used to compensate the ignition advance for changes in coolant temperature. This 
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 can be used to compensate for reduced flame speeds at low temperatures or to retard ignition 
 at high temperatures to prevent engine knock. 

 This is not applied to cranking ignition advance. 

 Throttle Closed Ignition Advance 
 This map is used to derive the ‘Base Ignition Advance’ degrees when the throttle is closed and 
 ‘Idle Ignition Advance Mode’  is set to ‘1’ in the configuration menu. 

 It is derived using ‘Engine Speed’ as its input. 

 Air Temperature Sensor Conversion 
 This map is used to calculate the air temperature in degrees Celcius from the resistance of the 
 air temperature sensor. 

 Air Temperature Sensor Conversion 
 This map is used to calculate the air temperature in degrees Celcius from the resistance of the 
 air temperature sensor. 

 Battery Voltage Scaling 
 This map is used to calculate the real battery voltage from an internal value which has the range 
 0-5V. 

 Injector Dead Time Compensation 
 This map is used to calculate the time in milliseconds that it takes the engine's fuel injectors to 
 open at a given battery voltage. It is applied each time the injectors are opened to inject a 
 specific amount of fuel. This ensures a consistent amount of fuel is injected despite changes in 
 battery voltage due to system loads and state of battery charge. 

 Injector Linearisation 
 This map is used to compensate for the non-linearity of injectors at low opening times. It is a % 
 modifier to the compensated fuel time that is applied at the point of injection. The input is the 
 ‘Injector Pulse Length’ which is the time that the injector should be open before the injector dead 
 time is added. Note that this is not necessarily the ‘Compensated Fuel Time’ as in Batch 
 Injection strategies the injector may  be opened twice or more during each 4-stroke cycle. 

 Ignition Coil Dwell Compensation 
 This map is used to calculate how long it will take the ignition coil to reach peak current during 
 dwell at any particular battery voltage. This is used to ensure maximum spark strength with 
 minimum heat generation within the coil and associated circuitry. It represents the time in 
 milliseconds that the coil is put into dwell prior to an ignition event. 

 Minimum Idle PWM Valve Duty 
 This map is used to calculate the minimum pulse width for the idle stabilisation valve based on 
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 the current ‘Coolant Temperature’. This helps ensure idle stability across the range of operating 
 temperature of the engine. 

 Boost Solenoid Duty 
 This map is used to calculate the base boost solenoid duty when boost control is active. It is 
 based on the ‘Engine Speed’. The higher the solenoid duty the higher the boost pressure that 
 will be obtained. 

 Over Boost Limit 
 This map is used to calculate the ‘Over Boost Limit’ using the ‘Engine Speed’. This is a fuel cut 
 threshold that is designed to protect the engine in the event of excessive turbo boost pressure. 
 The value is in ’Manifold Absolute Pressure’. 

 Target Boost Pressure 
 This map is used to calculate the ‘Target Boost Pressure’ for the closed loop boost control 
 algorithm. The value is in ‘Manifold Absolute Pressure’. 

 Target AFR 
 This map is used to calculate the target ‘Air Fuel Ratio’ for the closed loop fuel control algorithm. 
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 Appendix 5 - Fault Flag Descriptions 

 Fault  Descrip�on 

 Base Fuel  Map contains a data error. 

 Igni�on Advance  Map contains a data error. 

 Ba�ery Voltage  Map contains a data error. 

 Dwell Time  Map contains a data error. 

 Injector Dead Time  Map contains a data error. 

 Coolant Temperature  Map contains a data error. 

 Air Temperature  Map contains a data error. 

 Igni�on Air Temp Comp  Map contains a data error. 

 Fuel Air Temp Comp  Map contains a data error. 

 Igni�on Coolant Comp  Map contains a data error. 

 Startup Enrichment  Map contains a data error. 

 Injector Linearisa�on Error  Map contains a data error. 

 Thro�le Sensor Error  The thro�le switches are in an incorrect state. Or test mode 
 indicates the thro�le is closed. 

 Coolant Temperature Sensor Error  Map contains a data error. 

 Air Temperature Sensor Error  Map contains a data error. 

 Flywheel Tooth Sensor Error  Not used 

 Reference ToothSensor Error  Not used 

 Air Fuel Ra�o Sensor Error  Not used 

 Thermocouple Sensor Error  Not used 

 EEPROM Error  There is an error with the saved configura�on data. E.g. data 
 corrup�on. 
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 Injector Handler  There is an error condi�on in the fuel injector handler so�ware. 

 Target AFR  Map contains a data error. 

 Target Boost Calcula�on Error  Map contains a data error. 

 Speed Calcula�on  Not used. 

 Boost Duty  Map contains a data error. 

 Min Idle Valve PWM  Map contains a data error. 

 Igni�on Cranking Advance  Map contains a data error. 

 Cranking Fuel  Map contains a data error. 

 Over Boost  An over boost event has been captured. 

 Timer BISR  So�ware error. 

 Watchdog Reset  The ECU watchdog was triggered and reset the ECU. E.g. engine 
 stalled. 

 Power Reset  Indicates the ECU power reset. This is not an error as such but 
 an indica�on flag. 
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